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Welcome to Memories Builder DVD Version 2.1. This tutorial will guide you through the 
basic steps of creating a DVD presentation using Memories Builder DVD. 
 
NOTE: Before beginning this tutorial, copy the Tutorial folder from the Resource Disc to 
your desktop (recommended) or another location that you can access and remember.  
 
Following the steps in this tutorial will help you get acquainted with the DVD-Video 
format and the Memories Builder program at the same time. Once you have completed this 
tutorial, you should have the knowledge that you need to build a great project. 
 
 

Before Beginning 
While most people are familiar with DVD videos, not many have tried to create one. This 
short section will help you understand the DVD-Video format from an authoring 
perspective. A DVD is made of three types of content: Menus, Videos, and Slideshows. 

Menus (see top image at right) 
DVD menus form the structure of your presentation and provide 
navigation for users. The Title Menu (top level menu) is the first 
thing that viewers will see when viewing the DVD multimedia 
supplement. From this menu, viewers click on a DVD menu button 
to launch a video, slideshow, or submenu. A menu button can be a 
graphic, a still frame, or a motion preview of a video file or 
slideshow.  

Videos (middle image) 
Videos are high-quality, digital movies that, most likely, will make 
up the largest portion of your DVD. 

Slideshows (bottom image) 
A slideshow is what you would expect - a sequence of timed still 
images. With Memories Builder you can customize slideshows in a 
number of ways, including adding a background image, adding 
background music, setting the time interval between slides, and 
placing images, custom shapes, and text on the slides. 
 
 

What You Will Learn 
By the time you complete this tutorial, you will know how to: 

Create a New Project Add a Video 

Plan the Project Add a Slideshow 

Rename a DVD Menu Customize a DVD Menu 

Create a New DVD Menu  
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The Memories Builder DVD Program 

 
 Contents Window – Shows the structure of the project 
 Project Workspace – Displays the menus and objects. This is where users will select 

and edit slideshow objects and menu names. The gray area around the outside shows 
parts of the presentation that may not be visible when viewing the DVD on a TV. 

 Program Menus and Toolbars – Contain Memories Builder DVD’s functions. The 
toolbars have icons for the most common functions. 

 
 

Creating a New Project 
1. Open Memories Builder DVD. It will display the Where would you like to save your 

new project box. If not, choose New Project from the File menu. 
2. We will now choose the folder in which you will save the tutorial project.  

 
3. By default, Memories Builder will save your project in the Memories Builder DVD 

Version 2.1 program folder in a folder named DVDProj. We recommend that you use 
this folder unless your computer systems administrator instructs you to save to another 
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location. To choose a different folder for your project, click on a folder name. You can 
select a different hard drive (or network drive) by clicking on the Drive drop-down 
menu. Expand folders by clicking on the plus and minus symbols next to them (right 
and down arrow symbols on the Mac).  

4. When you have made your selection, click on the Choose button. The project name 
prompt appears. 

5. Now we will choose a name for the project. Type Tutorial in the box and click OK. 

 
 
 

Planning the Project 
Memories Builder next prompts you to plan the project. The planning process includes: 
• Project quality setting (sets the balance between amount of content and video quality) 
• Create project structure (menus) 
• Assign menus and deadlines, estimate contents 
• Project plan summary (with option to print) 
 
Because this tutorial focuses on the basic program functions, we will move through the 
planning section quickly. 
 
1. Click on the Plan button. 

 
2. At the Project Quality prompt, click 1 Hour. This settings gives us higher video quality 

but limits the amount of content we can include to one hour. 
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3. The next dialog box is for setting up your menu structure. Click on the Select All 
button to add all of the pre-entered menus to the Tutorial project. Click Next. 

 
4. The next few dialogs present the detailed options for planning your project. Glance at 

each one to familiarize yourself with its options. Click Next in the Project Deadline 
dialog. 

 
5. Click Finish in the Plan Project dialog, the screen for entering specific deadlines for 

menus and indicating who will be providing the content. 

 
6. After you click Finish in the Planning Summary dialog, Memories Builder will create 

your project. 



 

6 

Renaming a DVD Menu 
You can change a menu’s name at any time. In this case, we will change the name of the 
title menu. 
1. Locate the Contents window on the left side of the program and double-click on Title 

Menu. 

 
2. A box appears, prompting you to type in a new name. 
3. Type in North Star High School and click OK. 

 
 
 

Creating a New DVD Menu 
We will now create a new menu. The DVD-Video format allows you to add up to 99 titles. 
A title is a menu, video, or slideshow. 
1. Click on the New Menu icon from the Contents Tools. 

 
2. A box appears, prompting you to name the menu. 
3. Type Graduation in the name box and click OK. 

 
4. Memories Builder will now create the menu as a submenu 

of the selected menu. In this case, the new menu will be 
created as the last submenu of the title menu (North Star 
High School). It will appear in the Contents window as the 
last item in the menu. 
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5. Practice creating a submenu by selecting the Sports menu in the Contents window and 
then clicking on the Add Menu icon. Name the submenu Basketball and click OK. 
Notice how Memories Builder creates the new submenu inside the Sports menu. 

 
 
 

Adding a Video 
Now we’ll add a movie to the DVD project and move it so that it becomes the third item in 
the North Star High School menu. 
1. Click once on the North Star High School menu in the Contents window to select it. 

Memories Builder will place videos and slideshows inside the menu item that is 
selected in the Contents window. 

 
2. Click on the New Video icon from the Contents Tools. 

 
3. The File Preview window appears. Click on the Desktop icon in the middle (on the 

Mac, click on the From drop-down menu and choose Desktop). Double-click on the 
Tutorial folder to open it, click on Pie Eating.mov, and click Open.  
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4. Memories Builder will begin copying the video file to your presentation. 

 
5. When it is done, the video appears as the last item in the North Star High School menu.  

 
Notice that the menu button that links to the video appears by itself on a new menu 
screen. This is because a menu screen will only display six menu items at a time. Since 
this video file is the 7th menu item in the title menu, it starts a new menu page. Double-
clicking on the left-pointing arrow icon at the bottom right of the menu takes you back 
to the first menu screen. 

 
6. Next, we will move the video so that it shows up as the third menu item. Locate Pie 

Eating in the Contents window. Click on the name of the video and hold down the 
mouse button. Begin dragging the mouse up. A light gray line will show where the 
menu item is moving.  
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7. When the line indicates that the video is in between the Activities & Events and 
Organizations menu items, release the mouse button. Click on North Star High School 
in the Contents window. Notice that the video now appears as the third menu item on 
the menu screen.  

 
You can rearrange any menu item at any time. For example, if you would like the 
Student Life menu to appear before the Sports menu, just click and hold on Student Life 
in the Contents window and drag it to its new location. 
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Adding a Slideshow 
In this next section, we’ll use a folder of images to build a slideshow presentation. 
1. Click on Student Life in the Contents window to select it. 
2. Click on the New Slideshow icon from the Contents Tools. 

 
3. A box appears, prompting you to name the slideshow. 
4. Type in Candid Photos for the name and click OK. 

 
5. To begin building the slideshow, click on Candid Photos in the Contents window or 

double-click on the Candid Photos menu button in the workspace. 
6. For this tutorial, we will build our slideshow using Auto Slide Builder, a tool which 

places images you select on slides. As you build your own slideshows, you also may 
place images individually by choosing Add Image from the Insert menu. To begin using 
Auto Slide Builder, click on the Auto Slide Builder icon. 

 
7. The Auto Slide Builder dialog appears. Click on the Add button.  
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8. In the select folder dialog, click on the Look in drop-down menu and select the desktop 
(on a Mac, click on the drop-down menu near the top of the browse dialog, choose your 
username, and then double-click the Desktop). Double-click the Tutorial folder. Click 
on the Candid Photos folder. Click on the Open or Choose button.  

 
9. Memories Builder will take you back to the Auto Page Builder dialog. Next, click on 

the Choose Templates button. The Template Selector dialog appears. 

 
10. In this dialog we’ll choose the layouts for the slides that Auto Slide Builder will create. 

Uncheck all of the boxes except the ones next to 1 Photo-Full and 2 Photos-2 (be sure 
to scroll down to the templates that aren’t visible). Click OK.  
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11. This will return you to the Auto Slide Builder dialog. We’re now ready to start the Auto 
Slide Builder. Click on the Start button to begin. 

 
12. When the progress bar reaches 100%, Done appears just below the bar. Click on Close. 

 
13. A series of slide thumbnails will appear at the bottom of the workspace with the slides 

that Auto Slide Builder created.  

 
14. At this point, we’ll customize the slideshow. Click on the Slideshow Settings icon from 

the Slide Tools. 
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15. The Slideshow Properties dialog allows you to customize the slideshow in a number of 
ways.  

 
16. Drag the Slide Interval slider over one mark to the left. This will shorten amount of 

time each slide displays to 3 seconds. 

 
17. Click on the Background tab. 
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18. Click on the Memories Builder Background Library icon. 

 
19. In the File Preview window, double-click the Rings folder. Click on Blue_Rings.jpg and 

click Open. 

 
20. You will be returned to the Slideshow Properties dialog. 
21. For more information on slideshow properties, see the Slideshows section of the User’s 

Guide.  
22. Click on the OK button to close the Slideshow Properties dialog. Memories Builder 

will update the slideshow with the new background and slide interval. 
23. Next, we’ll place a title on the first slide. In order to do that, we’ll need to create some 

room. Click on the image on the first slide to select it.  
24. Click on the middle of the image and drag it near the top of the slide, holding the mouse 

button down. The mouse cursor changes to a move icon and a light gray outline will 
show where the image is moving. When you release the mouse button, Memories 
Builder will move the image.  
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25. Click on the Modify menu and move your mouse to the Align item. A new submenu 
appears. Click on Center Horizontal on Slide. This will place the image in the middle 
of the slide. 

26. Now, click on the Text icon from the Slide Tools.  

 
27. The mouse cursor becomes a crosshair. Click and hold just below the image and drag 

open a wide area, extending almost to the bottom of the slide.  

 
28. When you release the mouse button, the text box will appear with a cursor blinking in 

it. From the Text Tools above the workspace, choose Times New Roman, 28 size, Bold, 
Center, and White. 

 
29. Click in the text box and type in Candid Photos. The first slide is now finished.  

 
 
Important Note: When using Auto Slide Builder, check every slide. Because of the 
automated nature of Auto Slide Builder, the best way to optimize slides is by viewing 
all of the slides, and moving or cropping the images. 
For more information about using Auto Slide Builder, including how to select 
individual images, see the User’s Guide. 
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Customizing a DVD Menu 
Now we’ll focus on changing the appearance of the menus. There are a number of things 
we can customize. 

Menu Style 
The first thing we will change is the menu style. The menu style affects a number of things, 
including the default menu title font, button font, and background image. It also changes 
the menu button appearance. Changing a menu’s style will change the menu style for all of 
its submenus that have not been customized. 
1. The Menu Tools, which are visible when a menu is selected, give us access to the 

functions for customizing menus. Click on North Star High School in the Contents 
window to display the Menu Tools in the upper right area of the icon bar. 

 
2. Click on the first icon from the Menu Tools, the Menu Style icon. 

 
3. From the drop-down list that appears, move your mouse over the Hollow style. Three 

choices will appear to the right of the arrow. Click on White Hollow.  

 
4. Memories Builder will update all of your project’s menus with the new style (since 

none of the project’s submenus are customized). 

Menu Fonts 
Next we will change the appearance of the menu title.  
1. Ensure that North Star High School is selected in the Contents window in order to 

display the Menu Tools in the toolbar icon. 
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2. From the Menu Tools, click on the Menu Title/Button Font icon. 

 
3. The Font dialog appears. 

 
4. Click on the Font drop-down menu and choose Verdana. 
5. Click on the Size drop-down and choose 36. 
6. Ensure that the Bold box is checked. 
7. In the Color section, click on the second color box to the left in the top row to choose a 

very light gray color for the text. 
8. The lower preview box will show an example of what the text will look like. 
9. Click on the Buttons tab to change the appearance of the menu button text. 
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10. Choose Verdana, 20 size, regular style (none of the boxes checked), and the same light 
gray color as the title font. 

11. Click on OK. Memories Builder will update the menu’s font style and all of its 
submenus that haven’t been customized. 

 

Change the background image 
You may also customize the menu’s background image. 
1. Click on the Menu Background icon. 

 
2. The Menu Background Properties dialog appears. 

 
3. Click on the Memories Builder Backgrounds Library icon next to the Background 

field. Note: The yellow folder icon is for browsing to your own custom files.  

 
4. In the browse dialog that appears, double-click on the Treeline folder. 

 



 

19 

5. Click on Blue_Treeline.jpg. Click Open. 

 
6. Click OK to close the Menu Background Properties dialog. 
7. Memories Builder replaces the menu background with the new background image. This 

change only affects the current menu. Once you have selected a custom background for 
a menu, it will not change, even if you change the menu style. You may disable it by 
checking the Don’t display custom background box in Menu Background Properties. 

8. As an additional option, you can use a movie as the background for a menu. A short 
segment of the movie will play in the background of the menu until a user selects a 
menu choice. To choose a background video instead of an image, see To create a 
motion (video) background in the DVD Menus section of the User’s Guide. 

 

Background Music 
Finally, we’ll add some music to the menu. The music will play in the background until the 
person viewing the DVD makes a menu selection. 
1. Click on the Menu Background Music icon. 

 
2. The Menu Audio Properties dialog appears. 

 
3. Click on the Memories Builder Music Library icon. Note: The other folder icon 

allows you to browse to custom audio files.  
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4. A browse window opens to the Memories Builder Music folder. Double-click the 
Special Moods and Events folder. 

5. Click on the Paparazzi-short-60sec.mp3 file. A preview bar appears in the upper left 
side of the browse window. Click on the play button to hear the file. 

 
6. When you have finished previewing the file, click on the Open button. You will be 

back at the Menu Audio Properties dialog with the new file in the Menu Audio field. 

 
7. Click OK to add the music file to the menu.  
 
Finally, save your project often. Choose Save from the File menu or click on the Save icon. 

 

This concludes the tutorial. To see what the project looks like, click on the Preview icon.  
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